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Trainer & Consulting 

Overview 
 

Using advanced features in Order entry can streamline overall processing time.  There are several Order 
Entry / Quotes options and features that make generating orders and quotes much more efficient.  They provide 
an extra layer of information and assistance for more complex orders, and just generally assist you manage your 
data.  Other advanced features provide an extra layer of information needed for more complex orders. 
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Sample Checkout 

 

 

Samples are entered on a quote just like a regular line. If you use barcoding, samples can be entered into your 
inventory and then scanned when entering the quote line. Or, you can simply enter a line and indicate that the 
line represents a sample. To check out a sample: 

1.   In the Quotes module, click on the green plus sign to insert a Quote. 
2.   Enter the Customer Information. 
3.   Fill in estimated install/delivery date, salesperson and customer type. 
4.   Insert line and choose the product and color the customer is most interested in. 
5.   Enter a quantity of one. 
6.   Click on Sample box. 
7.   The Sample Information box appears defaulting to the current date ‘Out’ date and a ‘Due’ date 

of two days later. These dates can be overwritten 
8.   Fill in the deposit amount, if any. 
9.   Click OK.  Notice that the Sample line is now green and shows sample icon to the left of the line. 
10. To return sample, double-click on the sample line, click on Sample Info and enter return date or simply 

unclick Sample and click on Return. 
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A report can be generated to see what samples have been checked out or what samples or due or both. Select 

parameters to include stores and salespeople desired, how to sort it and to run a page for each salesperson 

individually

 

 

 

 

 

 

 

Using Bundles and Templates 

    

 
Bundles and Templates are grouping of either 

specific products and their matching pieces, or 

a generic listing, created in Products, to help 

you remember all of the steps in a process. 

Associated product templates are also called 

bundles. The product bundles may be 

downloaded directly from B2B or another 

product service, or you can build a product 

template in Products. When a product 

template is available, you are alerted in Order Entry. 
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Splitting Lines 

 

To split an existing line, click on the Split Lines button that is located just below the customer order line area on 

the customer order. 

This function is applicable for items and labor (product codes 03-99) and for roll goods (product codes 01 and 02), 

provided the roll line has not been assigned.  

Before you split a line, lock the line total on the original line to prevent a change in the invoice total from rounding 

errors This function may also be helpful when doing Partial Billings. You may divide original line entries and assign 

only those portions that you wish to bill for. 

For example, one of your line entries may be for 200 yards of pad. When assigning there may be several different 

inventory records for the same pad, each with only a small amount available.  If there are 40 yards on one record, 

50 on another instead of adding new lines to the order, you can "split" the line. 

Enter the quantity of for amount desired and the system will create a new line for with the identical information as 

the original. Those lines can then be assigned to the inventory records you wish to use. 

If you split a line that is linked to a work order line, you must regenerate the work order line after the split. Area 

and notes on the work order line do not split. 

 

 

Combining Customer Order Lines 

 

The lines to be combined must be in a none status. Combines TAGGED lines. The lines must be the same style, 

product code, color. Lines can't be combined unless they are exactly the same (not including area name). The 

areas for both the lines are put on the combined record.  
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Line Grouping 
 
 

A Group tab has been added to the browse 

which will present the Lines in Line Group 

Order. If an Order Line is not specifically 

assigned to a group, it will be automatically 

assigned to “Line Group None” 

 

 

When adding a new order line click on F8 to 

change the Group or to add another group. 

      

 

 

 

 

 

The dialogue box will appear to select the Group desired to be associated with the line. If Default Product Codes 

are set up the Group will automatically be populated based on that mapping. 
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Also, note that below the browse, it shows the Line Group Description as well as the total of Lines for the 

highlighted group. Highlight a record and the Line Group Total will be displayed at the bottom of the line browse 

screen. 
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Printing with Sub Total (Line Grouping Feature) 
Printing for Invoice / Acknowledgement, Estimate or Claims all have the same “Line Grouping” feature added. If the 

Lines for the document being printed do have Line Groups specified, Line Grouping will be enabled and will be set 

to the last grouping request for that type of document. 
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Set up Line Grouping 
From the Group F8 click on the ADD button to generate a new Group Description and color.   

 

 
The Group can be associated with 

Default Product Codes that will 

automatically populate the group when 

that product code is selected.  In some 

cases a product code may have multiple 

surfaces it can be associated with (i.e. 

adhesives, cove base, underlayment) so 

those would be left blank so the user can 

associate them with the group that 

material is being used with. 

 

 

 

Additional Information Tab 
These fields allow users to specify more information on each order and allow you to run reports based on that 

information. These fields are user defined by their drop down choices. Titles of all except ad source can be changed 

from the Public Parameters. The choices are built from the File menu. Reports are currently in development but 

information is available now by printing the Material Analysis report to CSV file. 
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Locking Fields 
Sold to, Sales Reps, Tax Status and Line Total/Unit Price can all be locked by using the padlock icon. It is 

recommended that a password be set to unlock the padlock button.  Locking the field prevents it from being 

changed either directly or by changing another aspect of the record. 

 

Quote or Order LINE 

 

 

 

 

Tax Status on Quote or Order 

 

 

 

         Sold To Section of Quote or Order 

 

 

 

 

 
 

 

 
 



 

Advanced Order Entry – 2018 
 Page 10 
 

 

 

 

 

Print Options - NEW Save as file or PDF History and Email  
  

The ability to email a quote or order 

directly from the print option screen has 

been added. It is now possible to 

automatically save the order as a PDF 

record in the default RFMS directory 

without any additional effort.  There is also 

the option to save the document to PDF 

history where it can be referenced or 

reprinted at any time. 

 

For Email PDF functionality to work 

properly the users email configuration must 

be set up in System Options/Users/Email 

Configuration 
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PDF History 
 

Users will easily be able to browse the PDF History and view each of the reports that have been printed for an 

order, quote, job etc... To see the pdf history, click the pdf button. If there are no pdf files attached the button will 

be gray. To view the actual record, click the view button. This will actually launch PDF document for all 

functionality available with the version installed on the workstation or server 

 

 

 

Tracking History 
 

Users will be able to browse Order Tracking information on every record insert made into Orders, Quotes and Bid 

Pro Estimates. Order Tracking Information will only be fully populated from the 10.6 install forward. Click the Order 

tracking button to see history. 

To see the full history, check the show extended view box. This will show other orders, quotes and bids that are a 

source or destination related to this record. 
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Baseline 
 
This screen allows you to create a baseline for the highlighted customer order or the billing group that order is a 

part of. The baseline is a "snapshot" of the order at that moment in time. You may also print a report that 

compares a previous baseline with the order in its current status. You can use your baseline points to compare how 

a job is doing over a period of time and the final quantity, cost, selling price and gross profit percentage. 

 

 

 



 

Advanced Order Entry – 2018 
 Page 13 
 

 

 

Accounts Receivable  
This screen allows access to the Accounts Receivable information menu. Select the options desired to filter the 

customer information. This is a very efficient way to access an individual invoice for a particular receivable account.     
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CMM Integration 
 

Clients with the Client Management module can add an alert, appointment, task, remark or letter for each 

order/customer in Order Entry.  See Client Management for full instructions for this functionality 

 

 
 

The 

Line highlighted above is a REMARK which any user can access in many places in RFMS to record information 

against a Customer or Record (Quote, Order etc).  Think of them as permanent notes that can’t be accidentally 

cleared.   
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A remark requires a Remark Type which is available 

for searching on the Find or binoculars icon. 

 

 

 

 

 

 

 

Overages 
How to add an overage for a customer order: 

 

 

 

 

From Overage Screen click on ADD 
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Open the lineup that has the total 

from the ORIGINAL line. 

 

 

 

 

 

 

Fill in the TOTAL price including the original amount  what will bill charge to 

the Overage client 

 

 

 

 

 

The difference between what was on the ORIGINAL invoice  
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Split Commissions 
There is a private parameter to allow users to view and edit the split percentages on orders and quotes 
Split commissions will affect sales reporting and commission reporting. 

 
 

Additional Commissions 
 
This feature allows you to pay extra or multiple commissions on any customer order. You may pay commissions to 

any customer, supplier or worker you have in your RFMS database. These commission amounts are paid in addition 

to commissions paid to the sales representatives. By attaching the appropriate customer, supplier or worker to the 

customer order and selecting the desired Commission Schedule, commissions are paid to that individual upon job 

cost. 

 



 

Advanced Order Entry – 2018 
 Page 18 
 

Billing Groups 

 
New or existing customer orders can be linked together by Billing Groups. To create or a new billing group or link 

orders together while highlighted on the new order or existing order and click the Invoice Billing Group icon. Fill in 

all the appropriate information (i.e. Billing Group Name, Finance Charge info, Retainage info.), then click Exit to 

save the new information 

Billing Groups and Partial Billing  
Partial Billing of customer orders is accomplished by using Billing Groups. The overall concept works like this 

(1) An order is entered for the entire job, 
(2) Material lines are split and exported to a new order(s) 
(3) A billing group is created that includes the original order and all new orders 
(4) Those new order(s) are job costed as they are completed 
(5) A billing notice is produced 
(6) The original is final billed when the entire job is completed. 
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Product Driven Order Entry 
Product Driven Order Entry is a process that allows you to select products ONLY from the Product records when 

entering a new line. This feature is designed to allow you to optimize the usage of current inventory as well as 

reduce waste. Before beginning to use Order Entry in the Product Driven mode you must do the following: Activate 

the Public Parameter "Product Driven Order Entry" located in 

Parameters, Public Parameters, Product Drive OE. There may 

be certain products you wish to select directly from inventory. 

Highlight these products as exclusions. Set the appropriate 

information in the field called "Product Driven Order Entry 

Roll Pre-Select Values". This parameter will set a guideline for 

the system when choosing the appropriate roll inventory. This 

parameter requires a high value and a low value. 
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Batch Processing 

Order Entry>File>Batch Processing or F12  

 

Batch processing of picking tickets, picking sheets work orders (Including Custom Work orders) and cutting lines is 

now available. 

The batch processing screens are similar to the customer orders browse screens. Orders are listed when picking 

tickets or work orders is selected and lines are listed when Cut lines is selected. 

 

Tool bar 
No editing is available from the tool bar. 

Use to find a specific range of records or a specific record. Alternately click the Find Tab on the left hand side. 

This find works the same as the ones for Customer Orders and Quotes. The list stays when switching between 

processes until the batch processing screen is closed. 

Reset the browse list to include all records. 

View highlighted order or line 

View lines on highlighted order. 

View notes on highlighted order or line 

Once records are tagged, use this button to start processing. 

 

Cut Lines 
Lines cut, (staged or delivered in ERRM) already will not be listed. 

▪ Use the find option to decide which lines to display.  
▪ Choose to include rolls, items and services. 
▪ If ready to cut only is chosen only lines ready to cut will display. 

If not chosen, Inventory Lines in “None”, “Gen PO”, “On Order” or “Reserved” Status will be displayed and the 

status will show in pink. These Lines cannot be tagged for processing. The intent here is alert the user that there 

are Lines in the target filter that are not ready in the event that these Lines were overlooked for ordering. 
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Picking Tickets and/or Picking Sheets 
Orders available for processing are ones which are: 

▪ Not delivered 
▪ Either an Original order or a Claim 
▪ Have order lines in a cut status. 

Use the find option to decide which lines to process and format of Report 

• If Include Rolls, Items and Services are all checked, the Picking Sheet only shows Roll and Item 
Inventory, but will post Rolls, Items and Services. 

• If the user decides to only check Include Rolls, for a Roll Report, then only Order Lines with Rolls 
will be posted. Then for a second report only checks Include Items, then only Order Lines with 
Items will be posted. Services would be skipped entirely. 

• Picking Tickets act the same always. So, if only Include Rolls is checked, but “Picking Tickets – 
Stage Orders” is used, only those Orders that have Roll Inventory to process will be selected, but 
all eligible Lines on the Order will be processed. 

Work Orders 
▪ Not delivered 
▪ Either an Original order or a Claim 
▪ Cut 

Tagging Options 
Records are selected to be processed by tagging.  

▪ Left click on a record or highlight a record and click the tag/untag button or Right Click and then 
click tag/untag. Using tag all is usually done after using the find feature to narrow the list. 

▪ Once records are selected by tagging, clicking the Printer Button process batches. 

 Processing order is important! 
Once a Line is Delivered / Staged, it cannot be picked up again unless the user sets the Line back to cut, so do not 
choose one of the selections to deliver lines if you want to run another picking document. 
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Order Entry Reporting 

 

Providers History Reports  
The Provider Earnings History report can be used to generate a report identifying labor paid in advance for jobs in 

progress and not yet job costed. 

 

Certified Payroll 
This feature allows you to keep an audit trail of certified rates placed on certain jobs from a government level. For 

certain governmental jobs a specific minimum rate is set. This helps to ensure that providers are being paid that 

rate by providing a comparison between the actual and certified amounts. 

 

Price Change Report 
This selection prints a report of all selling prices that were changed on a customer order using an authorization 

code within the specified time frame. 

 

Soft Reserves Report 
This prints a report of all soft reserves entered against inventory. Print this report periodically to be sure you don't 

have soft reserves that are expired. 
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Batch Print 
This feature will allow you to post Invoices, Claims, Job Cost Sheets, Picking Tickets, Quotes and Work Orders to a 

“batch file” for printing. This “batch file” saves all stored documents until you are ready to print them. When 

printing any of the above mentioned documents, you will see an option labeled “Post to Batch”. Simply select this 

option and click the Print button. 

The “Post to Batch” option will be available on each of the above mentioned documents’ Confirm Print screen. 

 

Orders/Quotes Profit Report (from Sales Reports) 
This report is useful to spot check quotes or orders to see abnormal profit percent or zero cost lines. This report is 

similar to the Quotes report in Order Entry, but not identical. For Quotes and Undelivered Orders the Gross Profit 

% default same as in OE. The default Overhead % is inherited from the Standard Overhead Margin, but you can edit 

it here. 

 

 

My Commissions 
This option was added in version 11.2 to the Order Entry Reports for a sales rep to print their preliminary 

commission report. It uses the same report routine as the preliminary commissions report from accounting,  

but is limited to the sales rep which is printing it. 

For this report to be available the system must be set to in >Utilities>System Options>System Wide>General> 

Password on entry only must be set to yes 

Then the sales rep must have an associated password. Go to Utilities>Maintain Passwords>Add or Edit a 

Password>Select a user name. 

Enterprise Manager Users 

Make sure the User Name is associated with the correct Sales Person (RFMS Name). 
Go to Enterprise Manager>File>User/Group/Role Management>Insert or Edit 

Report Options 

The report menu option will then be visible when that password is entered on entry to the system.  
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Customer Pickup 

  

UTILITIES / SYSTEM OPTIONS / ADMIN SYSTEM OPTIONS   

“use customer pickup” in the Search Option Field for Text 

This feature is designed to have a client sign an electronic document and save and display that signature in Order 

Entry.  It is compatible with the Topaz System signature pads commonly available at your office supply store.  The 

Topaz software does have to be installed on any workstation needing to see the signature. 

However, a paper document can be generated and signed without the signature pad.  Simply print the picking 

ticket and with the order still highlighted select the Customer Pickup icon and print.  
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For details see “Customer Pickup” on the RFMS Help Desk 

 

 

Word Merge 

 

This feature exports the data from the selected records in Customer Orders, Quotes, or BidPro and 

creates a Microsoft Word Merge document for the Invoices, Quotes, or Estimates. 

By doing this, it allows RFMS users to customize these documents by 

• Adding fields 

• Deleting Fields 

• Changing Font Style, Size and Color 

• Changing the Placement of fields 

• Inserting Additional Text 

• Adding Supplemental Pages. 

  

To use this feature, a user must have Word 2007 or later on the workstation they are working on at 

the time.  Also, an understanding of how to use Microsoft Word is required.  RFMS will not offer 

support or training once the template and document are in Microsoft Word. 

             



 

Advanced Order Entry – 2018 
 Page 26 
 

 

 

Copy Browse Screen 
With this key combination, any open browse screen can be copied, including any part that cannot be seen, and 

pasted into an Excel Spread Sheet. 
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Special PO Info 
UTILITIES / SYSTEM OPTIONS / ADMIN SYSTEM OPTIONS / “special cost” in the Search Option Field for Text 

If this option is set to Yes, then a Special PO Info box will appear on the right lower side of the Order Line 

screen when the roll/item is pulled from Products.  The user will select that box to enter a special cost 

received.  Then, that cost will be indicated in the AutoPO screen in Inventory letting the order desk know 

that this is a special cost received. 

             

When the comment, special cost, quantity is entered and Status is changed to “GENPO” then in Inventory the 

“Special PO Cost Applied” will be indicated for the purchaser. 
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Customers with the Same Name 
RFMS now allows customers with the same names to be entered.  RFMS looks at the Customers Name and 

Telephone 1 field to see if it is a duplicate customer.  If those two fields are the same as one already entered, then 

it will not be allowed to duplicate. 

 

 

Batch Printing 
This feature allows batch printing Claims, Invoices, Job Cost Sheets, Picking Tickets, Quotes and Work 
Orders. Visit the following site and download a program called PDF995 in order to use this feature. 

http://www.pdf995.com/ 

Do not download the sponsored version.  The purchase of  the full version (PDFSuite) is 
recommended. This will avoid any popup windows during use. 

How this feature works 

This feature will allow posting Invoices, Claims, Job Cost Sheets, Picking Tickets, Quotes and Work 
Orders to a batch file for printing. This batch file saves all stored documents until you are ready to print 
them. When printing any of the above-mentioned documents, you will see an option labeled Post to 
Batch. Simply select this option and click the Print button. 

The Post to Batch option will be available on each of the above-mentioned documents-Confirm Print 
screen. 

 When you click Post to Batch, a pdf file is created in a subdirectory where your RFMS 
files are located. The last batch for the workstation for any batch type (Invoice, Quotes, etc.) will remain 
on the disk until the next time that workstation does another batch printout for that batch type. For 
example, you have a batch named Invoice1.pdf. In the event that the batch fails to print, it is simple to use 
Adobe Reader to load this batch and print selected pages. 

How to retrieve documents posted to batch files 
1. Click Reports and select Batch Print. A drop-down list of document types will display. 

2. Select the appropriate document by single clicking. 
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3. Choose the sort order by single clicking on the field names in the verbose column. 

4. Notice that the Rank number denotes the order of your sort. 

5. When you have selected the appropriate sort order for this particular document batch, click the 
print button. 

6. The documents will be combined into one .pdf file that will display after you do step 5. 

 

 

RFMS Smart Search 
This link will give a list of the fields that RFMS Smart Search looks at in each module. 

https://rfmsinc.zendesk.com/hc/en-us/articles/218333627-RFMS-Smart-Search-Fields 

This article is a good one to “follow” for new tips as they are added. 

https://rfmsinc.zendesk.com/hc/en-us/articles/218333637-RFMS-Smart-Search-Tips 

 

https://rfmsinc.zendesk.com/hc/en-us/articles/218333627-RFMS-Smart-Search-Fields
https://rfmsinc.zendesk.com/hc/en-us/articles/218333637-RFMS-Smart-Search-Tips

